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Why Blender?
Well, it's free, fast and stable. It can also be used for very complex models – it's much 
more suitable than GMax for example when working with large and highly detailed models 
– and it includes everything you might need to make mapping and texturing easier in one 
package. It can render and also 'bake' the results into the texture which means that 
highlights and shadows can be automatically generated, saving hours of work.
Additionally an exporter for Trainz is available, there are numerous tutorials on the Internet 
and the program is being actively developed. 
You can get Blender here: http://www.blender.org . I recommend the version without an 
installer as you can simply copy the whole Blender application anywhere you want without 
installing it, for example onto a USB stick. It's only about 30Mb in size and very fast so it 
works well from a stick.
Versions are available for Windows, Linux and Macs (and it doesn't have any problems 
running under Vista unlike GMax).

Disadvantages
The user interface is different to anything else you have ever seen before . Stick at it 
though, as once you are used to it you can work very fast and effectively. A minor 
disadvantage is that Blender doesn't keep track of whether you have changed the file 
or not when you close it, it expects you to know that (at least in v2.48a). Click on the the 
close icon and the changes are gone, never to be seen again.

About this Tutorial
This tutorial will attempt to guide you through the steps necessary to create your own 3D 
models which can be used in the Trainz Railway Simulator or any other program for which 
you can find an exporter. I won't attempt to explain all of the possibilities that Blender offers 
as firstly I haven't found out myself yet, and secondly a lot of the more advanced stuff just 
isn't needed.
You'll need to bring a certain amount of patience and perseverance with you, learning a 
new 3D application is a bit like learning a new language – you have to work at it.
Once mastered you can create any model that you desire though, so it is worth it. I 
couldn't use Blender either until I tried.
If you get stuck there are many, many other tutorials as PDFs or videos available on the 
Internet, but most of them use earlier versions of Blender. As Blender develops some 
major changes have been made to the interface which render the earlier tutorials out of 
date, so check to make sure that they are still relevant.
Hopefully this tutorial will concentrate on the bits of Blender that are important for creating 
Trainz models, filtering out the less relevant parts.
A useful resource is the Trainz WikiBook at 
http://en.wikibooks.org/wiki/Trainz/Tutorial_for_Blender which covers texturing, mapping 
and animation. It also has links to videos and other tutorials.
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The Interface
Once Blender starts you are presented with the following screen:

The 3D Cursor is the point at which new objects will be inserted, but it also has other uses 
which we'll come to later. It's position is set by a left mouse button click, so you'll have to 
get out of the habit of left clicking  to select something, although this can be changed 
which is a good way to introduce the options window. This is cunningly hidden at the top of 
the screen, it's part of the 'info' window (the bar with the big 'I' in it). Drag the window 
border down to reveal the options:
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Highlighted are a couple of useful settings, the mouse button to use to select things 
('Select with') and 'View Name' to display the name of the view in the view port. To make 
things more like GMax  or Max select 'Left Mouse' . This will mean that the 3D Cursor will 
be positioned by the right mouse button, and elements will be selected with the left button.
I recommend though that you don't change this, as all the tutorials assume the 
standard setting.
Incidentally the cube is outlined in pink 
which denotes that it is currently 
selected. 
OK, now with the mouse cursor over 
the main graphic window hold down 
the middle mouse button and move 
the mouse. The scene will rotate to 
show it from a different angle.
As you can now see, the cube is a 3D 
object. When Blender starts it loads a 
default scene which includes a cube – 
which is not a bad thing as you can 
edit the cube to look like anything you 
like. 
You can move the cube around by left 
clicking and  dragging on one of the 
axis arrows .
Also note the yellowish dot at the centre of the cube, this is the local origin point of the 
object (the pivot point in the GMax context) which among other things is useful when 
mirroring objects.
Panning the view is achieved by dragging with the middle mouse button and SHIFT, 
zooming with the middle mouse button and CTRL. 
If you get lost SHIFT and C will zoom the 
view to show everything and also centre the 
3D cursor at 0,0,0 (handy when you 
accidentally left click).
You'll find it useful to create extra views on 
the model you are making, this is in fact 
pretty much essential when you are working 
with background images (plans for example). 
To create a new window place the cursor on 
the window border and right click. From the 
menu that appears select 'Split area'. 
A line will be shown on the screen to denote 
the edge of the new window – click the left 
mouse button to split the window.
You should now see that you have two 3D 
windows looking at the cube.  
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Each window on the screen has a particular type, in this case '3D'. Things get more 
interesting when you realise that the type can be changed. 

Click  on the window type icon and 
choose 'Outliner' to display a tree view 
of the objects in the scene – this is 
similar to the object picker in GMax and 
Max. It allows you to hide/show objects 
and select/deselect them amongst 
other functions. 

You can of course split up the main 3D window further to provide top, side and front views 
for working with plans. The view direction is changed using the numpad number keys 
when the mouse cursor is over the window, 1 is front, 3 is side and 7 is top. To reverse 
the direction of view to get a rear view for example use SHIFT or CTRL and 1. When 
working on a computer without a numpad an option can be set to use the normal number 
keys which is often needed when using a laptop (or an EEEPC!).
The option window at the top of the screen needs to be pulled down and under 'System & 
OpenGL' you'll find the option to emulate the numpad keys.

Armed with this information we can set up the screen in any way we want. I have the 
outliner on the left, to the right of which I have side, front and rear views (depending on the 
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views I have of the object I am modelling of course) and then the main 3D view, like this:

I should have said of course that once a window has been split you can join them back 
together again by right clicking on the border and choosing 'Join Areas'. You can decide 
then which of the windows will be kept.
Any of the windows on screen can be maximised by using CTRL up arrow and minimised 
again using CTRL down arrow, to to model something in the side view instead of the 3D 
view put the mouse cursor over the side view, hit CTRL up arrow, do the modelling and 
then hit CTRL down arrow to restore the display. 
Fairly obviously the windows can also be resized by dragging the borders and views can 
be changed using menu selections, but it is far faster to use the keyboard short cuts.
Interestingly the options and windows that you set up are stored in the .blend file itself, not 
separately so each model retains the interface set up that you choose and when reopened 
looks exactly the same as you left it. The model that Blender opens when it starts can be 
changed to something that suits your preferences by simply setting up the interface and 
hitting CTRL-U. The next time you start Blender you will get your 'Start model' instead of 
the default.   
At this point it would be a good idea to practice using the interface by splitting windows 
and rotating, panning and zooming the scene until you have the hang of it. By the way, a 
useful short cut introduced with v2.48 is SHIFT-B which allows you draw a region to zoom 
in on.
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Editing and Selecting Elements
We've already seen that complete objects can be 
moved around in 3D space (left click and drag the axis 
arrows) and that selections are usually made with the 
right mouse button. It is also of course possible to edit 
the vertices, faces and edges of an object. To do this 
we have to change the selection mode. 
Here we are in 'Object Mode' which allows the 
manipulation of whole objects. 
Click on this field and choose 
'Edit Mode'. Assuming the cube 
was already selected the 
display changes to this:
All of the vertices are now 
selected. Hit A to deselect, A 
again to select all.
With all of the vertices 
deselected you can select one 
with the right mouse button and 
move it around using the red, 
green and blue axis arrows.
More than one vertex can be 
selected by holding down the 
SHIFT key when right clicking.

Faces and edges can be selected instead of 
vertices by selecting one of the icons shown 
here.
Once something has been selected it can be 
'grabbed' with the G key and moved along one of 
the axes by then hitting X, Y or Z.
There are also other possibilities to select things 
other than by clicking on them directly, such as B 
for a box selection or BB for a 'brush'.
Practice now selecting and moving things 
around,  CTRL-Z will undo any changes if they are not what you want. 
That's about it for the basics of Blender, I believe the best way to learn new 3D software is 
to actually use it, so we'll build a loco now and pick up the other techniques as we go 
along. You could equally well build a house or a wagon, but it's a good idea not to start 
with anything too complicated – my first loco was a simple diesel shunter which had the 
wheels hidden by skirts, not a BR standard loco with outside valve gear.

Page 8 of 49 Version 1.11



Whatever you want to make it's a good idea to have plans available and to use them to 
ensure that the proportions are correct, so the next thing to know is how to do this.

Using Background Images
With GMax and Max it was usual to apply the plans to a box or planes as a texture, but 
this is not a good idea in Blender. The problem is that to display the plans you have to be 
in the texture display mode which means the 3D model is as well and gets in the way. Also 
if you switch the model to wireframe mode the textures cannot be seen.
Blender has the ability to display a background picture in each view (which works properly, 
unlike the similar function in GMax) which is the best solution. 
Prepare the plans by scanning them in and cropping them in a bitmap editor such as 
PaintShop Pro or GIMP, they can be any scale and (almost) any format (GIF or JPEG are 
good). The bitmaps don't have to be any particular size and do not have to be square. 
I'm using as an example an LNER Y7 tank loco, a nice small and simple model. Scan the 
plan in and make sure that the horizontal lines really are horizontal, rotating the image if 
necessary. Crop the image to make side, front and rear images, ensuring that the height of 
each is the same. Obviously if you have a top view you can prepare that as well.
To display a bitmap in a 
view port choose 'View -
> Background image' in 
the appropriate window.

Click on 'Use Background Imag' 
(sic)
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Click on 'Load' – a file selector will open 
to allow you to pick the image to use. 
(The tool tip shown here should read 
'Load new Image or Movie'...)

Now navigate to 
where the 
prepared side 
view has been 
saved and load it.
As you can see 
the background 
image has been 
positioned so that 
it's centre is at 
0,0.
In order to scale 
the image to the 
correct size you change the 'size' value in the 'Background Image' dialogue. At the 
moment it is set to 5.00 which means 5 Blender units. Blender doesn't do units such as 
metres or inches, it always works in Blender units which can be anything you like. 
The Trainz exporter uses the convention that 1 Blender unit is 1 metre although the latest 
version includes a scale option so that you can work in feet and export in metres.
To get the background image the right size you need to know how long the original was, 
the size that you input is then the original size/2 as Blender calculates the size of the 
image as an offset from 0,0. 
In this case the full sized loco was 6.155 metres long, so the size in the background image 
dialogue box needs to be 3.077. To move the image so that the rail level is at 0,0 
change the Y Offset to be the same as the Scale value (if anybody can explain why this 
works I'd be grateful, there doesn't seem to be any logic behind it...). Incidentally the 
'Blend' slider adjusts the transparency of the image.
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To anybody used to working with the fuzzy, 
inaccurate display of plans that GMax is limited 
to, the quality of  the background images will be 
a welcome surprise. Blender has another 
surprise up it's sleeve though, the bitmaps that 
you use for texture and background images can 
be stored in the *.blend file itself. This means 
that the one working file contains all of the 
information need to display it properly. 
Selecting the tiny icon highlighted here tells 
Blender that the image should be packed into 
the *.blend file.
To actually pack the images you need to choose 
'File-> External Data-> Pack into .blend file' as 
shown here. Finally 'File->Save' (or CTRL-W) will save the *.blend file together with the 
embedded bitmaps. It's a good idea to avoid huge bitmaps though, these will increase the 
loading and saving times.
You can also unpack the bitmaps again if you need to do so.
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Repeat the steps outlined so far to create views for each of the scans that you have, i.e. 
side, front and rear views. If you've been paying attention you should be able to get this far 
without too much trouble:

Note that the side, front and back views are named '... Ortho' This is 3D application speak 
for 'display without perspective', which is important for views that contain background 
images.  You switch between Ortho and Perspective by hitting the numpad 5 key – try it on 
the main 3D window to see the difference.
Having set up the interface and prepared the plans we can now start to model. There are 
only a few basic techniques needed for this such as creating a profile and adding a 
thickness and rotating a profile to make a round object. Normally I would start by creating 
the wheels and coupling rods but I have a GMax macro to do this I I would be mad to build 
them in Blender when I can do it in about two minutes in GMax.
Converting objects from GMax to Blender is possible, but it's pretty hard work without the 
appropriate tools which are not free. Using the following techniques there is absolutely no 
reason why you can't make the wheels and rods in Blender.

Creating Meshes From Profiles
Let's start with the footplate to demonstrate a few 
things. Blender doesn't do lines by the way, it only 
has faces and vertices - what looks like a line is a 
face with no thickness. To start select the cube 
with a right click, switch to Edit mode and press 
the DEL key. From the menu choose 'Vertices' to 
erase the existing geometry.
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Switch the main 3D window to top view with numpad 7 and make sure you are in Ortho 
mode by checking the view name at the top left of the view (you have switched on view 
names haven't you?). Obviously if we have set up a top view with a plan beforehand we 
could use that window instead of the main one.
Choose 'Edit mode':

Now we are ready to sketch the shape of 
the footplate. Remember that Trainz 
convention has it that the front of the loco is 
on the -Y direction, so hold CTRL and left 
click about here:
Blender has created a new vertex in the 
cube object and selected it.

Now we'll extrude the vertex to create the rest of the 
shape with by hitting E and then X to extrude to the 
right (direction +X):
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Carry on extruding until the shape looks something 
like this:

Note that the first and last points are not at the same 
coordinates – no problem, 
select them with a right click 
followed by a SHIFT right 
click  and then hit the W key. 
From the menu first menu 
choose 'Merge'
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From the second menu choose 'At Last'. In this 
case the first vertex you selected (or a group of 
vertices, very useful) will jump to the position of 
the last one you selected. The other options 
should be self explanatory...
Hit W and choose 'Remove Doubles' to weld the 
vertices together. Don't forget to do this 
otherwise the following steps won't work!

To move a vertex to a 
particular coordinate 
you can select it and 
then hit the N key. This 
opens a dialogue box 
where you can input 
the exact coordinates. 
In this case one of  the 
vertices near the 
centreline is not at 
X=0, so edit the value 
and hit ENTER to set 
it.

To create a mesh from this shape select all the vertices 
and press SHIFT-F:
That wasn't too hard was it?
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Now to make a solid body out of the faces select them all (after creating them they stay 
selected) and choose the following menu option:

Make the thickness about 10mm 
(0.01 Blender units). The result 
looks like this:
A thickness has been added to 
the mesh.
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Switch to the Right Ortho view (mouse cursor over it, CTRL up arrow to maximise it) and 
adjust the footplate to match your background image. To do this you need to use the B key 
to make a box selection, A to clear selections and the GY and GZ key presses to move the 
vertices to the correct positions. Once you've sorted out the side view do the same for the 
front view to get things the correct width. 
Note that we've only modelled half of the footplate, this is an old CAD trick to save time. 
The whole body can be mirrored about the YZ axis to make the right side. As you'll see 
later  Blender has some more tricks up it's sleeve for making mirrored copies of meshes 
compared to GMax and Max.
Using this basic technique you can carry on and create the frames,buffer beams, 
valences, cab and tanks as well as some of the smaller details.
Let's make the buffer beam as these will use some new techniques.

Extruding Edges and Snapping
A useful technique for building up a mesh is extruding. We've already seen that you can 
extrude a vertex, it's also possible to extrude an edge. Switch to wireframe mode by 
pressing the Z key (press again to switch back to shaded mode). Make sure you are in 
Edit mode (the TAB key toggles this) and that the edge select button is selected. Select 
the upper edge at the front of the footplate so:

Press E (to extrude) and then Z (to constrain movement to the Z axis only). It's best to do 
this in the side view so that you can see how far to extrude by referencing the plan. So, 
mouse cursor over the Right Ortho view and press CTRL up arrow. 
If you know the distance you want to extrude you can simply type it in. In this case a 
negative value will extrude downwards, positive upwards. To extrude +100mm, input 
0.1 (Blender units).
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By extruding the edge in the X 
and Z directions we arrive at 
this result:
Now we want to extrude in the 
Y direction, but only as far as 
the front of the footplate. 
Blender has a real time saving 
feature for this, you can snap 
to existing vertices, edges or 
faces.

To turn this on, press SHIFT-TAB or select  the highlighted 
icon:

Now press E and then Y and 
hold down the CTRL key while 
dragging:
By the selected edge (yellow) 
moves along the white line (the Y 
axis) and snaps to the 
coordinates of the vertex under 
the mouse cursor (the white 
circle).

Switch now to face select mode and select the faces belonging to the buffer beam using 
right click and SHIFT right click. When in face select mode each face has a small dot at its 
middle point making it easier to select. The .faces turn pink when they are selected

Page 18 of 49 Version 1.11



We are now going to split the buffer beam away from the 
footplate to make a second object. To do this simply press P 
and choose 'Selected' from the menu.

We now have a second object called 'Cube.001'. 
Switch to Object mode and select it.

Now switch back to Edit mode and select 
the bottom rear edge of the buffer beam. 
Extrude it in the Z direction using a vertex 
on the top face of the beam to snap to. You 
can complete the buffer beam by extruding 
the top horizontal edge of the beam, 
snapping to a vertex on the bottom edge.
To keep things tidy you can rename the 
objects using the 'Transform Properties' 
dialogue box by typing a new name in the 
OB: field.
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Making Round Objects and Moving the 3D Cursor
The next major technique we will need is to rotate a profile around a centre point to create 
a round object ('Lathing' in GMax parlance).  There are a couple of things to watch out for 
in Blender, for example the rotation centre is always the centre of the 3D cursor. Also the 
rotation axis is always normal to the view  - you cannot rotate around a line or a point for 
example.
Switch to the Right Ortho view and create a 
new cube with SPACE Add ->Mesh -> Cube. 
Select the new cube and switch to edit mode. 
Delete all the vertices (press DEL and choose 
'Vertices') to leave an empty body to create the 
new object. Make sure that you still in Vertex 
editing mode and sketch the outline of the 
buffer using a combination of CTRL left mouse 
clicks and extruding as we did for the footplate.
I'd recommend doing the buffer head itself 
separately as it really needs more segments 
(polygons) than the ram and the housing. The 
base of the buffer in this case is square so we'll 
need to do that with a cube.  Now we need to 
position the 3D cursor to the centre of the 
buffer.
The simplest way to move the cursor is just to left click, but this is of course not very 
accurate. The cursor can be moved to a particular coordinate by accessing the View 
properties though. For now, left click to set the cursor position.
Now switch the main 3D to front by pressing 
1 and press F9 to bring up the mesh editing 
panel at the bottom of the screen. Select all 
the vertices of the buffer profile with A and 
set up the mesh panel is shown here:
'Steps' is the number of segments to create, 
'Degr' the rotation value in degrees. Click on 
'Spin' – the cursor will change to a question 
mark if you have more than one 3D window 
visible. Click on the main window to create 
the rotation body.

Page 20 of 49 Version 1.11



The result looks like this:

Create the buffer head in the same way, 
but be careful not to move the 3D 
cursor by accidentally left clicking as 
the head needs to have the same 
rotation centre as the housing.
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To create the square base for 
the buffer housing make a new 
cube with SPACE  -> Add -> 
Cube (the new cube will be 
created centred on the 3D 
cursor which is exactly what we 
want) and select the cube in 
Object Mode and press S, 
dragging to scale it down to the 
right size using the plans as a 
reference. 
Use the snapping tool to align 
the front and rear faces of the 
cube to the buffer beam and the 
rear of the buffer housing.

Joining Objects Together
This is dead easy, in Object Mode select the objects with right click and SHIFT right click 
and press CTRL J. Note that the joined object will take the name of the last object that you 
clicked on. Select all the individual parts of the buffer now and press J to join them.

You can rename the buffer object at this stage using the 'Transform Properties' dialogue 
box (press N if it is not open already). Clean up the mesh by going into Edit Mode, select 
all the vertices, press W and choose 'Remove Doubles'. This will remove the duplicate 

Page 22 of 49 Version 1.11



vertices created by the spin operation.
Now we have to move the pivot point of the 
buffer to it's centre point so that we can 
move it to the correct position. In Object 
Mode click on 'Centre New' in the Buttons 
panel.
The pink dot will jump to the geometric 
centre of the buffer object.

The 'Transform Properties' dialogue 
box now shows the coordinates of the 
buffer:

For UK locos the buffers were almost 
always at 5'8” (1.727m) centres and 
at a height of 3'5” (1.041m) above rail 
level. The Z height of the buffer in this 
case is only 9mm too low which is 
near enough, and the X coordinate is 
0. This needs to be changed to 
1.727/2 = 0.864. Type this into the 
'LocX:' field and hit ENTER. The 
buffer will jump to the new X 
coordinate. 
Before duplicating the buffer it would 
be a good idea to add any extra detail 
such as bolt heads at this stage, but 
we'll skip that for now.
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Removing Unwanted Polygons
Before we start duplicating the objects to make the other buffers and the rear buffer beam 
we can remove a few polygons that cannot be seen in the finished model, for example the 
rear face of the square part of the buffer housing. With the buffer object selected go into 
Edit Mode (press TAB) and make sure that the selection mode is face. Simply select the 
polygons that you want to delete and press DEL, choosing 'Faces' from the Erase Menu.
Other polygons that can be removed at this stage are at the centreline of the footplate.

Copying and Rotating Objects
To copy and object select in in Object 
Mode and press SHIFT D. Do this on 
the buffer and the buffer beam objects 
to duplicate them, rotating the buffer to 
face in the opposite direction. This can 
be done by selecting the object and 
using the 'Transform Properties' 
dialogue box (it needs to be rotated 
180° in Z of course).
Using the snap tool position the new 
buffer beam and buffer relative to the 
other components.
As a reminder: select the object, move it 
with G and then Y, holding CTRL to 
snap the object to an existing vertex. 
This makes building a mesh so much 
easier.

Mirroring Objects
To save time we'll mirror the footplate over to make the right hand side. First, join all the 
objects together by selecting them and pressing J. Rename the object to body_mirrored or 
some other sensible name using the 'Transform Properties' dialogue.
The mirror plane is positioned at the pivot point of the 
object and this needs to be at X=0 in this case. 
Unfortunately it is not possible at the moment to 
move the pivot point directly, but it can be moved to 
the position of the 3D cursor.
Set the 3D cursor to 0,0,0 by pressing SHIFT C, and 
in the Mesh panel click on 'Centre Cursor'.
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Now click on 'Add Modifier' in the 'Modifiers' panel.

Choose 'Mirror'.

Done. Now that the mirror 
modifier has been applied any 
modification to the left hand side 
of the mesh will be automatically 
applied to the right hand side.
Also anything joined to the 
mirrored mesh will be mirrored to 
the other side, another great 
time saver.
Surprisingly perhaps we have 
already covered most of the 
steps and techniques needed to 
create a mesh in Blender.  
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Splitting a Mesh Object Apart
Looking at the buffers again it looks as 
though the buffer ram I made is a bit too 
small, so I'll split it out of the mesh, scale 
it up and reattach it. Select the body 
object and switch to 'Edit Mode' and and 
sure you are in face select mode and the 
object is displayed as wireframe  (press 
Z). Select the faces making up the buffer 
ram and press P to split the mesh up.
Do the same for the rear buffer ram but 
delete the faces with DEL instead of 
splitting them out.

When you split an object that has a mirror modifier applied 
the modifier is also applied to the mesh that you split out. 
Joining two meshes with a mirror modifier seems to 
confuse Blender, so it is best to delete the modifier on 
the mesh that you have separated. 

Now that the buffer ram is a separate object we can set the pivot point to the centre of it 
and rescale by pressing S. Having fixed that the ram can be aligned to the buffer head and 
housing again using the snap tools. Joining  the buffer ram back to the footplate object will 
mirror it again about the X axis.
I could have done this without splitting the buffer ram from the main mesh, but it was 
useful to demonstrate how to do this.

Creating a Bolt Head Using a Cylinder
Another primitive that is available is a cylinder, which 
can be used for such things as boilers. We'll use one 
to create a bolt head for the buffer housing though 
(items that needed maintenance at regular intervals 
were never riveted, rivets have to be cut away to 
detach the item).
To create a cylinder it's SPACE and then Add -> Mesh 
-> Cylinder. As a bolt head has six sides I've changed 
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the value of 'Vertices', the default is 32 which is higher than you'll 
need even for a boiler. Watch out how many segments the final 
cylinder will have, they can cause the polygon count to increase 
rapidly. 
The cylinder is pretty huge, but we can scale it down easily. First 
though it needs rotating by using the 'Transform Properties' 
dialogue (press N if it is not open). Rotate it 90° about the X axis 
and scale it down by pressing S. Switch to the Front Ortho view 
and eyeball the cylinder into position, scaling it to 
suit. The snap tools can be used to position it on 
the front face of the square flange of the buffer 
housing. You'll find it easier to work in wireframe 
mode as otherwise the buffer head obscures the 
cylinder. Also press G to grab the selected 
cylinder as you can then move it in X and Z just 
by dragging.

Moving the Centre (Pivot) Point of an Object
The pivot point has remained 
at the centre of the cylinder 
during this manipulation, but in 
order to create the other bolt 
heads we'll need to move the 
pivot to the centre of the buffer. 
To do this we can select two 
diagonal vertices belonging to 
the square base of the buffer 
and then position the  3D 
cursor midway between them. 
Here the two vertices have 
been selected:
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By pressing SHIFT S and the 
choosing Cursor -> Selection the 
cursor can be positioned.

Select the cylinder again and choose 'Centre Cursor' in 
the Mesh panel. The pink dot snaps to the 3D cursor.

Resetting the Transformation of an Object ('Reset XForm')
Now that the pivot pivot of the 
cylinder is correct there is one more 
thing to do before applying a mirror 
modifier to create the other 3 heads 
and that is the equivalent of 'Reset 
XForm' which resets the rotation of a 
object back to World Coordinates. 
Simply press CTRL-A and choose 
'Scale and Rotation to ObData'. 

Page 28 of 49 Version 1.11



More Mirroring
Now apply a mirror modifier to the cylinder choosing X and 
Z and the choose 'Apply' to remove the modifier and leave 
4 bolt heads.

This is the final result. The bolt heads can be 
duplicated, rotated 180° and then positioned on 
the rear buffer housing using the snap tools. The 
polygons of the bolt heads that are in contact 
with the buffer housing can of course be 
removed as they can't be seen, and it would 
have been smarter to do the bolt heads before 
duplicating and mirroring the buffers themselves, 
but it is in any case very quick and easy to do it 
afterwards.

Joining the bolt heads to the main mesh will mirror them over to the other side 
automatically.

Using Library Parts
Any object in a *.blend file can be merged into another one and we can use this to speed 
up mesh creation by creating standard parts that can be picked out of the library files as 
required - a Library file is simply another *.blend file.
The current library that I have created can be downloaded here.
To demonstrate the use of it we'll add the 3 link couplers to the model. Press SHIFT-F1 
and find the library file that you have downloaded. Click on 'Object' in the list to see the 
list of available objects in the library file. 
Choose the sub mesh '0_coupler_3_link' and click on the 'Load Library' button. The '0_...' 
naming convention is to remind me that the sub mesh is already positioned relative to the 
0,0,0 coordinates. It is also possible to load sub meshes at the current 3D cursor position 
which is useful for smokebox doors for example which can be inserted at the centre of the 
smokebox if the 3D cursor is correctly positioned. This option is controlled by the 'At 
Cursor' button in the mesh selection window. Actually it's a good idea to always insert at 
the cursor position as then you are not relying on the objects being positioned in a certain 
place in the library file(s).
It is also possible to insert multiple objects in one go by selecting them with the 
right mouse button.
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Here the coupler mesh has been inserted.

All that remains to do is to move the coupler (the 
snap tools are handy here) to the front of the 
buffer beam and to duplicate and rotate it for the 
rear beam.

Selecting and Smoothing Elements of an Object
If you look closely at the buffer housing you can see the individual facets that make op the 
shape. This is because we haven't smoothed the mesh yet. To select the buffer housing for 
smoothing select one vertex on the housing (you have to choose the left side ones as the 
right side is mirrored and cannot be edited directly) and press CTRL-L. This will select all 
of the welded vertices of the object in the same manner as Element select mode in GMax 
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and Max. 
We are in Edit. Wireframe and vertex select 
modes here, and one vertex of the housing 
is selected.

CTRL-L selects the linked vertices:

Click on 'Set Smooth' to smooth the faces 

The buffer housing has been smoothed 
(the mirrored copy on the right side as 
well!). Repeat for the rear buffer and the 
buffer heads and rams.
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Creating Library Sub Meshes
You may notice that all of the stuff that we have created so far could be used as library 
objects for other models. To do this all we need to do is to merge the mesh into a Library 
file and then split it up into suitable objects.
In this case we can save the mesh as it it now as 'MyLibrary' for example, open it and then 
break the mesh apart using CTRL-L  to select the sub elements and P to split them out. 
Any mirror modifiers should be deleted and the pivot points of the objects should be 
moved to a sensible location (such as 0,0,0 for buffers) to make insertion in other models 
easier.
We should also do any smoothing and welding needed before extracting the sub meshes 
as this will be retained when we merge them into other models.
So, save the current model as 
'MyLibrary' using File -> Save As 
(or press F2). Open this model 
and in 'Edit Mode' and 'Vertex 
Select Mode' pick one vertex on 
each of the elements that make 
up the buffer.
In this picture you can see the 
dumb buffers that I have added 
to the buffer beam and the 
footplate valance which I 
shouldn't need to explain how to 
do!

Break the buffer out of the mesh, rename it in the 
'Transform Properties' dialogue box and delete 
the mirror modifier on the object.
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Set the pivot point to 0,0,0 by moving the 3D 
cursor there if it is not already and choose 
'Centre Cursor' in the Mesh panel.

Repeat for the footplate and buffer beam to create the other Library objects. Once you 
have built up a library of common parts it is possible to model very quickly indeed.

Building the Tanks and Rounding Corners
The tanks and cab side sheets are quite straightforward, the only new technique to master 
is filleting the corners of the cab side. Blender unfortunately doesn't do fillets – it is 
possible to create circles and use parts of these as fillets though. I tend to make the 
corners square and use the bevel tools to create the fillets though.
We'll start by sketching the 
basic shape in a new 
object, so create a cube 
and then delete all the 
vertices. In the empty 
object we'll create a shape 
by CTRL left clicking in 
Vertex Mode. 
As you can see it's a bit 
inaccurate, but if we select 
all the vertices and press 
SHIFT-S we can snap all 
the vertices to the grid, 
squaring up the shape.

Now we adjust the horizontal and 
vertical lines to match the scale 
drawings.
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To fillet the corners select a 
vertex and press W, 
choosing 'Bevel' from the 
menu.

Drag the vertex with the left 
mouse button to create the 
bevel. Bevel the two new 
vertices again to finish the 
fillet.
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Repeat for the other fillets.

Try to get four nicely spaced vertices for each 
fillet. They can be grabbed with the G key and 
adjust afterwards of course.
Create the faces by selecting all the vertices 
and pressing SHIFT-F. The tank and cab side 
can now be moved to the correct X coordinate 
and the object finished off by extruding edges 
or creating new shapes for the front and rear 
cab sheets which can be built as shown here.
The technique can be used to make all the flat 
sheet parts of the loco, such as the frames 
and brakes.
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Making the Boiler
To make the boiler we'll insert 
a new cylinder with 24 vertices 
and no end caps...

And now rotated and scaled 
to match the scale 
drawings... The smokebox 
has been created by 
extruding and scaling the 
front end of the boiler, this is 
easier if the boiler is a full 
360°.

The vertical sides of the smokebox were made by deleting the 8 faces at the bottom of the 
circular smokebox and extruding the free horizontal edges downwards. The new faces 
were then detached with P and moved and resized to match the scale drawing. The area 
between the vertical faces and the circular part of the smokebox was filled by extruding a 
few faces. The front face of the smokebox was made by selecting the vertical free edges 
and pressing SHIFT-F.
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More on Selecting and Smoothing
When we apply smoothing to the boiler 
object we get a result that we don't want in 
this case. The sides of the smokebox 
should be smooth but the front should be 
flat. The ugly shading on the smokebox 
front is caused by Blender trying to smooth 
around a 90° corner.
A very useful possibility for selecting faces 
is to limit the selection to adjacent faces 
that are within a certain angle tolerance of 
the first one selected.

Go into 'Edit Mode' on the boiler object and 
select one of the faces on the smokebox front, 
then press ALT-CTRL-SHIFT-F. All the adjacent 
faces on the smokebox front will be selected, but 
not the curved sides.
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Once the faces have been selected we can do 
'Set Solid' on them to remove the smoothing.

That's better...

Chimneys and Domes
These can made in the same way as the buffers, a 2D profile 
rotated around the 3D cursor in the top view. It's worth only 
making a quarter of the object and then mirroring it though as 
the vertices at the base will need to be adjust to fit neatly on 
the boiler or smokebox.
Here I've sketch the shape of the chimney and have set the 
3D cursor to the centre of it (hopefully). It the centre is a bit 
out I can always scale the object afterwards. 
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Switch the main 3D view to Top Ortho by 
pressing 7 and then 5 if the view was not 
already in Ortho mode.

Now spin the chimney 90° with the steps set to 6. 
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Switch to 'Object 
Mode' and apply a 
mirror modifier in X 
and Y to complete the 
chimney, but don't 
forget to move the 
pivot point to the 3D 
cursor first as the 
mirror needs to be 
about the centre of 
the chimney.

Finally in the 3D view and in shaded mode 
the edges of the base of the chimney must 
be moved in Z so that they just touch the 
smokebox. In the side view adjust the other 
vertices to make a smooth base for the 
chimney.
This is made a little easier by the fact that 
we only have to adjust a quarter of the 
vertices in the chimney base.
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That's it for the chimney, it just needs 
smoothing and we are done. Domes, 
safety valve covers and whistles can be 
made using the same technique.

Beading and Window Frames
Start by selecting the edges that make 
up the beaded edge or the window 
frame:
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Extrude the selected edges, separate 
then from the body mesh and delete the 
mirror modifier.

Select all the faces of the bead/frame and apply the 
'Solidify Selection script with a suitable value to add 
thickness.

Here I've extruded the end face to add the extension 
for the handrail.
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On the other side I've 
shortened the beading up to 
the start of the radius for the 
handrail extension and have 
positioned the 3D cursor to 
the approximate centre of the 
radius.

The curved end of the beading is then created 
with a 90° spin. A similar method can be used 
to create pipework incidentally.
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Finally the thickness can be reduced to about 50-60mm. In 
reality the beading was quite wide as the handrail down to 
the footplate would be around 32mm diameter.

Handrails and Pipework
This is about the only thing I've found so far that is harder in Blender than in GMax. 
Blender lacks a method of sketching the centreline of a pipe and then adding a thickness 
to it (having said that there probably is a script somewhere to do this, but I haven't found 
one yet).

In the absence of this it is necessary to create a circle 
and then extrude it to make a hand or handrail.

Position the circle at the highest point of the handrail in 
the side view....
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In this case the handrail is centred on the boiler, 
so set the 3D cursor to the boiler centreline and 
using 'Spin' create the first part of the handrail in 
the front view. You'll have to guess what angle is 
needed, in this case it was 45°, but if you get it 
wrong just hit CTRL-Z and try again.

The next step  is to find the centre of the next radius, I just 
eyeballed this and created the next segment of 45°. Note 
that the handrail is being created a bit higher than the 
drawing shows, the height has been taken from the side 
view as the drawing appears to be incorrect here, the 
handrail in the front view is draw too high (the boiler centre 
line is correct though). Unfortunately this is not uncommon 
in published drawings. The best thing is to take as much 
information as possible from the side view and only widths 
from the front view.
Switching to the top view the handrail was 
completed with an extrusion in X, a 90° 
spin with 3 segments around a new 
position for the 3D cursor and an extrusion 
in the Y direction.

Organising the Model, Layers and Hiding/Showing Objects
As the model gets more complicated it becomes harder to see what is going on – luckily 
Blender comes with several helpful tools built in. At the simplest level whole objects can be 
made visible and invisible in a similar manner to GMax. To do this you can use the 
'Outliner' window which displays the scene as a tree view.
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The three icons for each scene 
object can be toggled by left 
clicking on them with the mouse.
Toggling 'Visibility' off hides the 
object, on shows it again. In the 
same way 'Selectability' can be 
toggled which is useful when you 
have problems selecting the 
correct object. GMax and Max call 
this function 'Freeze'.
Toggling 'Renderability' excludes 
or includes objects in the scene 
renders. This is useful if you have 
a mirror plane in the scene (which 
normally extends the render 
time) , for a quick render the plane can be excluded.
All well and good, but a bit limited. Blender also has the possibility to 
work with layers, which GMax doesn't have. A layer can be thought of as 
a transparent sheet containing objects which can be shown or hidden, or 
as a way of grouping objects together. Blender doesn't waste a lot of screen space on 
layers, it's just a group of 20 boxes as shown here.
By default objects are created on layer 1 and only the active layer is displayed. The grey 
background to the box means that the layer is visible, the small circle that geometry is 
present on the layer. Multiple layers can be displayed by SHIFT left clicking the boxes, the 
active layer is the last one selected.
To move whole objects to a particular layer select 
it (or them) and press M followed by the layer 
number, i.e. M and then 2 to move the objects to 
layer 2.
To make working on a particular object easier it is 
possible to switch to what Blender calls a 'Local' 
view. This shows only the currently selected 
object(s), zooms the view to show the object as 
large as possible and centres the 3D cursor on 
the geometry.
Any new objects created in this mode are also 
displayed making it easy to work on objects in 
isolation.
To get back to the 'Global' view select it as shown 
in the View menu.
On a German keyboard with numpad emulation 
active the hotkey is '^', for other keyboards some 
experimentation may be needed!
For quickly hiding something there is also the H 
key, which hides anything selected. To unhide 
hidden objects press ALT-H. Interestingly this 

Page 46 of 49 Version 1.11



allows faces and vertices as well as whole objects to be hidden.

Surface Normals and Flipping Them
The 'normal' is the direction of a face or a vertex. Each face has a visible side and an 
invisible side – the visible side is the viewable side. During the construction of the model it 
is almost certain that some of the faces will have reversed normals which need correcting 
before the mesh is textured and exported, otherwise the faces will have the wrong shading 
in-game or will be displayed inside out.
A quick way to check the mesh is to switch to 
the 'Textured' display mode instead of 'Solid' 
or 'Wireframe'. As the mesh hasn't been 
textured yet faces that are correctly 
orientated will be displayed in white, those 
with reversed normals in black. Here we can 
see that the chimney and cab roof have the 
normals inverted.

Another possibility is to actually display the surface 
normals. Select the cab roof object and switch to 
'Edit' and ''Face Select' modes. Press F9 and then 
click on the 'Draw Normals' icon in the 'Mesh Tools' 
panel.  You don't need to actually select the faces, 
just be in the right mode.
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The normals for this object will now be 
displayed (the blue lines).

To invert a normal select the faces 
(SHIFT-CTRL-ALT-F to select linked 
faces is useful here) and press W 
and then 0 (or W and choose 'Flip 
Normals' from the menu). The 
normals should look like this in this 
case:
Obviously if you are cleverer than me 
– or less impatient to see the finished 
mesh – you can save time by 
checking the normals as you create 
stuff, or at least before you start 
mirroring and copying objects 
around.

Adding Attachment Points
These are needed for an item of rolling stock, the minimum would be three points called 
a.bog0, a.limfront and a.limback. Blender doesn't have points as such, instead an object 
called an 'Empty' is used instead which has the same appearance as a point in GMax or 
Max. Create the Empty object by pressing SPACE and choosing Add → Empty from the 
menu.
These can be positioned exactly like other objects, but the naming and positioning of the 
Empties is important and is described in more detail in the Content Creation Guides. 
Luckily they do not have to be created in the 'Top' view to get the orientation correct as in 
the case in GMax and Max.
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And Finally
Obviously not all of the possibilities for creating a mesh have been covered here, but 
hopefully the basics have been. There are many, many other tutorials available on the 
Internet that will suggest more techniques that can be used.
If anybody has any suggestions for improved techniques or problems following this tutorial 
let me know by mailing me at paul.hobbs@web.de . 
The (almost) finished model used in this tutorial can be downloaded here 
(LNER_Y7.blend)
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